CURSO: AUTOCAD 2006-2008 Revisado
1. INTRODUÇÃO

· CAD:

           Computer Aided Design (Desenho/Projeto Auxiliado por Computador).

           Os     CAD    são    programas   que   foram   concebidos   para   auxiliar 

           profissionais na área de representação gráfica.

· O que esperar de um sistema CAD?

· Primordial para o seu funcionamento: o ser humano.

· É uma extensão do meio convencional, necessita-se de conhecimento básico sobre desenho.

· É um instrumento de desenho que substitui os instrumentos tradicionais tais como régua, prancheta, compasso, transferidor, entre outros.

· CAD x Desenho Manual:

      Um sistema CAD  apresenta  as  seguintes  vantagens  em  relação  ao

      desenho manual: 

· Maior tempo dedicado a reflexão e a criação 

· Racionalização no método de trabalho (menos empirismo)

· Maior precisão

· Aumento na produtividade

· Melhoria na qualidade do produto

· Elimina o redesenho e os trabalhos repetitivos

· Facilidade na edição do desenho: permite apagar, copiar, duplicar

· Rapidez, Eficiência, Flexibilidade

· Características inovadoras:

         - Desenho em escala real

              - Variação de escalas

              - Obtenção de cópias 

              - Cálculo de áreas e perímetros

         - Cotagem automática

         - Sistema de bibliotecas

         - Sistema de camadas

         - Desenho inteligente

              - Etc.
· O que é necessário para usar um sistema CAD?
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                                                                 - IBM PC/ XT/ AT/ 486

                                                                 - Pentium     
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· AutoCAD:

                        É o programa de CAD mais usado no mundo, é adotado como 

                        padrão   mundial   nas   indústrias   para   projetos   e   desenhos 

                        auxiliados por computador. É um programa genérico que pode 

                        ser usado por profissionais das mais diversas áreas. 

2. COMO CRIAR OU ABRIR UM DESENHO

O AutoCAD 14 começa com uma caixa de diálogo de nome Start Up através da qual o usuário pode selecionar uma das opções de abertura:

· Use a Wizard:
         Permite que o usuário especifique alguns parâmetros do desenho.

· Use a Template:

          Inicia um desenho com características predefinidas por um template

          do AutoCAD.

· Start from Scratch:

         Inicia um desenho sem características básicas predefinidas. Obs.: o 

         comando new da barra de ferramentas também permite iniciar um 

         novo desenho.

· Open a drawing: 

           Abre  um  desenho  já existente dentro do AutoCAD. Obs.: o comando 

           open também pode ser  acessado  através  da  barra  de  ferramentas 

          (toolbar)

· Obs.: O menu pull-down File permite abrir de novo rapidamente um dos

     últimos arquivos que foram abertos no AutoCAD.

3. COMO SALVAR OU DESCARTAR UM DESENHO

· Save (Salvar)

File => Save.

Atualiza o desenho sem sair do editor gráfico. Se o desenho ainda não tiver um nome, este comando apresenta uma caixa de diálogo pedindo um e salva-o. Se o desenho já tiver um nome este comando salva-o sem apresentar a caixa de diálogo.

· Save as  (Salvar como)

File=> Save as.

Salva o desenho sempre apresentando a caixa de diálogo.

· Qsave (Salvar rápido)

Este comando atua como o save. A maneira mais rápida de acessá-lo e através do ícone do tool bar que apresenta um disquete.

· Recover (Recuperar)

File => Drawing utilities => Recover

Permite recuperar um desenho danificado.

· Exit (Saída)

File => Exit

Realiza a mesma operação do comando quit(sair). Ele apresenta uma caixa de diálogo onde indicamos se queremos salvar as alterações do desenho ou não.

4. INICIANDO O AUTOCAD

· A Tela Gráfica

A tela gráfica do AutoCAD divide-se nas seguintes áreas:

· Janela de Aplicações

· Janela de Desenhos

· Janela de Linha e Comandos

· Linha de Status

· Janela de Aplicações

Esta janela contém o menu de barras, a barra de propriedades dos objetos, e a barra de ferramentas (nesta ordem). O menu de barras possui somente alguns comandos do AutoCAD, o restante dos comandos foram colocados em ícones para facilitar seu uso e memorização. A barra de propriedades dos objetos  tem os comandos Layer, Color, Linetype e Linewidth, que são as propriedades dos objetos mostrados através de ícones. A barra de ferramentas possui ícones padrão do Windows e ícones de comandos do AutoCAD 
· Janela de Desenho

Nesta janela serão criados os desenhos. Nela se encontra o cursor de desenho. Nela também podem ser acrescentadas as barras de comandos (ToolBars) que também podem ser inseridas na janela de Aplicações arrastando-as com o cursor. As barras de comandos são ativadas pelo menu Tools através da opção Toolbars.

· Janela da Linha de Comandos

     

Localizada na linha inferior da tela esta apresenta as digitações 

    

feitas pelo  usuário  e  os  prompts  que   o  AutoCAD  utiliza  para 



se comunicar com o usuário.

· Linha de Status

Localizada abaixo da linha de comandos ela nos dá a posição de algumas ferramentas de auxílio de desenho do AutoCAD que podem estar ou não ligadas. Quando ligadas elas aparecem em preto; quando não, em cinza. São elas: as coordenadas, os botões Grid, Snap, Ortho, Paper Space e a hora. Cada uma delas é ligada com uma das teclas de função (F6, F7, F8, F9).

· Alem das ferramentas de desenho mencionadas na linha de status, o AutoCAD tem outras ferramentas que são acionadas através do menu do cursor. Esse menu é acionado pressionando-se a tecla SHIFT e o botão direito do mouse. Nele temos comandos para auxílio de desenho (OSNAP).

· Teclas de Função

· F1: chama a função ajuda (Help);

· F2: permuta entre a tela gráfica e a de texto;

· F3: ativa e desativa o osnap;

· F4: ativa a mesa digitalizadora, quando instalada;

· F5: permuta entre projeção isométrica de topo, direita e esquerda;

· F6: mostra as coordenadas cartesianas absolutas,  ou as coordenadas relativas ou, então, bloqueia a exibição das coordenadas;

· F7: liga ou desliga o grid (grade auxiliar de pontos);

· F8: liga ou desliga o ortho (modo ortogonal);

· F9: liga ou desliga o snap (grade invisível de pontos eqüidistantes);

· F10: faz aparecer ou desaparecer a barra de status na tela.

· Esc: cancela o comando vigente.

· Organizando e Gerenciando Arquivos de Desenho

Os arquivos de desenho devem estar guardados em subdiretórios e por temas. Desta forma será fácil saber onde se encontram os vários tipos de desenho. Por exemplo:

AutoCADR2000

Curso-CAD-2000(Diretório)

Casa1 (Subdiretório)

Planta-baixa.dwg (desenho)

Para criar diretórios e subdiretórios pode se utilizar o Exploring do Windows ou o Meu Computador.

· Conceitos Básicos

· O AutoCAD trabalha no plano de coordenadas x,y,z. O desenho  2D  será feito em um plano cartesiano definido pelos eixos x,y que e paralelo ao plano da tela. A terceira dimensão do desenho 3D e determinada pelo eixo Z que e perpendicular ao plano da tela. A esse sistema chama-se WCS (World Coordinate System).

· Visto que a área de desenho do AutoCAD é infinita, os desenhos em geral são feitos em  escala  real (1=1),  e  a  escala  do  desenho  impresso  será dada ao plotarmos o desenho. Desta forma um mesmo  desenho  poderá ser plotado em diferentes escalas.

· Outro conceito importante é que o AutoCAD é baseado na idéia de

           unidade, e forma que 1 unidade de medida poderá ser considerada 1 

     metro ou 1 milímetro, dependendo do usuário

· Entrada de Comandos
Para selecionar ou entrar num comando o AutoCAD oferece as seguintes opções:

· Teclado

· Menu de Barras

· Barras de comandos

· Mesa Digitalizadora

· Teclado:

Todos os comandos do AutoCAD podem ser dado entrada via teclado, digitando-se o comando e pressionando Enter. Se o prompt do AutoCAD não estiver com o command você deve cancelar o que esta sendo apresentado pressionando a tecla Esc.

· Menu de Barras

Nesse menu temos alguns comandos do AutoCAD. Para selecioná-los clique sobre o menu com o mouse e depois clique sobre o comando. Ao entrar num comando, sua interação seguirá pela linha de comandos ou por uma janela de diálogo.

· Barras de Comandos

Cada grupo de comandos possui uma barra. Para acessar um comando basta clicar com o mouse sobre seu ícone correspondente. 

· Mesa Digitalizadora

Para acionar os comandos através de uma mesa digitalizadora basta colocar o cursor da mesa em cima do comando e clicar o botão de dados.

1. Começando a Desenhar no AutoCAD

· Limits (Limites)
Command: Limits (enter) ou Format => Drawing Limits

ON/OFF <lower left corner> <current>: 0,0 (enter)

Upper right corner: 294,197

O comando limits determina os limites do desenho corrente (fronteiras); o grid só ira aparecer dentro deste limite predefinido e o comando zoom all mostra a área definida por este comando a não ser que haja algum desenho for a desta área. Este comando é definido pelas coordenadas x,y dos vértices opostos de um retângulo, sendo as primeiras coordenadas x,y o canto inferior esquerdo do retângulo e as segundas coordenadas x,y o canto superior direito.

· Coordenadas

Além de determinar pontos clicando com o mouse sobre a tela, pode-se determiná-los com coordenadas precisamente definidas nos eixos x,y,z. Estes pontos podem ser obtidos através de coordenadas absolutas ou relativas.

· Coordenadas Absolutas

As coordenadas absolutas são introduzidas via teclado em pares ordenados x,y separados por virgula.

Command : Line (enter)

From point: 0,0 (enter)

To point: 100.5,70 (enter)
· Coordenadas Relativas 

Na maioria dos trabalhos (desenho arquitetônico por exemplo) , o uso de coordenadas absolutas será extremamente exaustivo ao usuário. Para facilitar o trabalho existem as coordenadas relativas. Este tipo de coordenada simula o deslocamento da origem absoluta para o ultimo ponto conhecido. As coordenadas relativas especificam uma distancia em relação ao ultimo ponto, podendo ser cartesianas ou polares. Nas coordenadas relativas você deve introduzir o caracter @ antes das coordenadas pretendidas.

· coordenada relativa polar: @x,y =>ex.: @100,40
· coordenada relativa cartesiana: @dist.<ang. =>ex.: @100<90
· obs.: apenas o @ e o mesmo que 0,0,0

· Line (Linha)

É a entidade fundamental de qualquer desenho. Permite-nos desenhar uma linha entre dois pontos dados. Você deve fornecer as coordenadas iniciais e finais da linha. Estas podem ser coordenadas absolutas ou relativas.

Command: L (enter) ou Draw => Line)

From point: (clica em um ponto sobre a tela) (enter)

To point: @50<0 (enter)

Dentro do comando line podemos ainda utilizar duas ajudas:

U (undo = desfazer): anula o ultimo segmento desenhado, mantendo seu ponto base. 

C (close = fechar): fecha o contorno definido pelo segmentos já desenhados, traçando um segmento entre o ponto onde nos encontramos e o inicial.

Obs. 1: se em resposta ao prompt From point for dado um enter, o começo da linha é colocado no fim da última linha ou arco desenhado. 

Obs. 2: se quiser cancelar qualquer comando pressione a tecla Esc.

Obs. 3: para repetir o último comando digitado pressione a tecla Enter.

· Erase (Apagar)

Apaga entidades de um desenho.

Command: erase (enter)

Select objects: (clica sobre o objeto) (enter)

Select objects: (enter)

· Offset (Afastar)

Cria uma entidade paralela a que foi selecionada a um distância determinada. Esta distancia pode ser especificada clicando sobre dois pontos na tela ou digitando-se um valor numérico 

Command: offset (enter)

Offset distance or through <through>: 10 (enter)

Select object to offset: (clique sobre o objeto) (enter)

Se introduzirmos o valor numérico 10, o AutoCAD vai traçar uma paralela a entidade existente a 10 unidades de distância. Da próxima vez que este comando for utilizado este valor aparecera por default.

Se ao invés de digitarmos um valor numérico, clicarmos sobre um ponto na tela, o AutoCAD pede:

Second point: (clique sobre a tela novamente) (enter)

E é a distancia entre estes dois pontos que o AutoCAD vai utilizar. 

Se escolhermos a opção T o AutoCAD irá traçar a entidade paralela no ponto indicado pelo usuário.

Obs.: o único método de seleção aceito pelo comando offset é o de clicar sobre a entidade.

· Oops

Repõe entidades que tenham sido inadvertidamente apagadas. Ele só é valido se for usado a seguir ao comando de que se quer anular a ação.

Command: oops (enter)

· Redraw (Redesenhar)
É um comando de visualização que limpa os ruídos ou marcas temporárias (blips) que o trabalho de edição vai deixando na tela.

Command: redraw (enter)

· Blipmode

Permite desligar a variável blipmode, de forma a evitar que o AutoCAD suje o seu desenho com a marcas temporárias (blips).

Command: blipmode (enter)

ON/OFF<On>: OFF (enter)

2. Visualização do Desenho

No AutoCAD é possível desenhar qualquer entidade, por maior que ela seja . Se quiséssemos desenhar o sistema planetário em escala natural, o AutoCAD teria dimensões que permitiria efetuar tal desenho. Existem comandos no AutoCAD que permitem controlar a visualização deste desenho na tela, sendo estes:

· Zoom

O comando zoom  permite ampliar ou reduzir a imagem da tela, sem alterar fisicamente as coordenadas dos objetos.

Command: Zoom (enter) ou View => Zoom

O prompt do comando dá as seguintes opções:

All/ Center/ Dinamic/ Extents/ Previous/ Scale (X/XP)/ Window/ <Realtime>: 

Para escolher uma das opções, digite na linha de comando as letras dessa opção que esta em maiúscula(s).

· All (Tudo)

Apresenta o desenho enquadrado nos limites previamente definidos pelo comando limits. Se as entidades de desenho saírem fora dos limites, esta opção apresentará uma área gráfica superior aos limites do desenho de forma a mostrar todas as entidades desenhadas.

· Center

Possibilita a determinação do ponto central da nova tela. Pode-se, ainda, especificar a altura da janela em unidades do desenho ou a magnitude da tela.

· Dynamic

Permite que de uma maneira interativa se escolha a região do desenho na qual o zoom será aplicado. Esta opção edita um quadro gráfico especial onde podemos visualizar o desenho pelo seus limites, juntamente com um conjunto de janelas que representam diferentes áreas desse desenho. As janelas visoras são desenhadas em diferentes cores. Uma janela branca sólida é desenhada para indicar extensão do desenho. Uma janela verde ponteada é desenhada para indicar a área de desenho visível no momento em que foi chamado o comando Zoom/ Dynamic. Uma janela ponteada azul indica a porção de desenho dentro dos limites gerada pelo AutoCAD e que pode ser vista com grande rapidez. É valido o movimento fora desta área mas força o Pan e o Zoom a serem executados a uma velocidade mais lenta. 

· Extents (Extensão)
Calcula a menor tela possível, que contenha a totalidade do desenho sem se importar com os seus limites.

· Previous (Anterior)

Permite retornar aos Zooms efetuados e visualizar a área anterior.

· <Scale (X/XP)>[Escala (X/XP)]

Permite dar um fator de escala ao Zoom. Se responder com um algarismo seguido de X, a escala é relativa a vista que no momento está ativa.

· Window (Janela)



É a opção mais utilizada. O AutoCAD pede para  indicar  a  área

que se pretende ampliar, através de uma janela definida por dois pontos. O centro da janela passa a ser o novo centro da tela.

Esta opção também pode ser acessada através da Standard toolbar.

· Realtime (Tempo Real)



Efetua um Zoom em tempo real. Isto é, permite variar o Zoom do

      

desenho através do movimento do cursor na tela.

· In [Zoom +] (Dentro)
Faz um Zoom automático de 2X, o que amplia a imagem para duas vezes a anterior. 

Esta opção não esta disponível na linha de comando. Ela pode ser acessada através do menu de barras: View ou através da Standard toolbar.

· Out [Zoom -] (Fora)

Faz um Zoom automático de 0.5X, o que reduz a imagem para metade. 

Esta opção não esta disponível na linha de comando. Ela pode ser acessada através do menu de barras: View ou através da Standard toolbar.

· Pan



Permite deslocar o desenho em qualquer direção sem alterar a

sua ampliação, fazendo aparecer partes do desenho que antes estavam ocultas. 

Command: Pan (enter)

Press Esc or Enter to exit, or right-click to activate pop-up menu

Se apertar o botão direito do mouse, surge o menu pop-up do cursor.

View => Pan => Point

-pan displacement: (primeiro ponto de deslocamento) (enter)

Second point: (segundo ponto na nova posição) (enter)

Este comando também pode ser acessado através da mãozinha da Standard Toolbar.

· Regen (Regenerar)



As    coordenadas,   ângulos,   raios,   etc.,   que    identificam   as

entidades do desenho são gravadas na base de dados do AutoCAD. Uma base de dados é um conjunto de informações necessário ao trabalho de um software. No caso do AutoCAD, a sua base de dados é constituída por toda a informação que diga respeito as entidades de desenho. Sempre que se modificam os valores das variáveis do AutoCAD ou se alterem as propriedades de uma entidade, dá-se um processo de regeneração. Este processo efetuado pelo comando regen atualiza toda a informação que diz respeito a base de dados das entidades desenhadas. Cada vez que uma regeneração é necessária, o AutoCAD emite a mensagem: Regenerating the drawing… informando que o AutoCAD está efetuando a regeneração.

Existe uma grande diferença entre este comando e o redraw, visto que o comando regen atua sobre todo o desenho e a sua base de dados, enquanto que o comando redraw apenas atua sobre a parte visível da tela. Por essa razão é aconselhável, na maior parte dos casos, a utilização do comando redraw, se pretendemos apenas limpar a tela.

Command: regen (enter)

O comando Viewres pode ser utilizado para controlar o número de regenerações automáticas realizadas pelo AutoCAD. 

Command: Viewres (enter)

Do you want fast zooms ?<Y> (enter) (ao aceitar esta opção o AutoCAD só irá realizar regenerações quando for essencial, aumentando assim a velocidade do trabalho)

Enter circle zoom percent (1-2000) <100>: (enter) (esta opção permite controlar a definição de arcos e círculos através do numero de vetores que os irá compor).

· View (Visualização)

O comando view permite ao usuário ganhar tempo em desenhos onde é necessário diferentes visualizações ou detalhes, especialmente quando é necessário trabalhar em diferentes áreas do desenho de um forma repetida.

Command: View (enter)

?/Delete/Restore/Save/Window:

· ? 

Mostra a lista das visualizações que já foram gravadas no desenho.

View(s) to list<*>: (enter)

· Delete (Apagar)



Remove uma visualização anteriormente gravada.

View name(s) to delete: (nome da visualização que queremos apagar) (enter)

· Restore (Restaurar)

Substitui a imagem corrente por uma outra já salva anteriormente, tendo que para isso indicar o seu nome.

View name to restore: (nome da visualização que queremos restaurar) (enter)

· Save (Salvar)

Salva uma imagem para posterior utilização. É pedido um nome e em seguida a imagem que esta disponível na tela é salva.

View name to save: (dar um nome a visualização que queremos salvar) (enter)

· Window (Janela)

Esta opção, tal como a anterior, salva uma imagem, mas a definição da área de imagem é feita através de uma janela e os objetos que ficam fora da janela não são visualizados.

View name to save: (dar um nome a visualização que queremos salvar) (enter)

First corner: (clicar num ponto referente ao primeiro vértice da janela) (enter)

Other corner: (clicar num ponto referente ao segundo vértice da janela) (enter)

· DdView

Este comando apresenta uma caixa de diálogo interativa chamada View Control que faz o controle da visualização.

Command: Ddview (enter)

ou

View => Named Views

ou

clicando sobre o ícone Named Views da View toolbar

· Obs.: 

Os comandos Zoom, Pan e View podem ser utilizados de forma transparente enquanto um outro comando esta ativo. Para isso deve-se digitar um apóstrofo seguido do comando, por exemplo: ‘Zoom. 

· Dsviewer (Visualização Aérea)
Permite ao usuário ver a totalidade do seu desenho através de uma janela independente. Esta janela permanece sempre visível e acessível, sem necessitar de qualquer regeneração. Se o usuário desejar é possível fazer Zoom(s) e Pan(s) em qualquer área pretendida.

Command: Dsviewer (enter)

7. Seleção de Entidades

Qualquer modificação que o usuário queira fazer ao seu desenho, tem de passar necessariamente, pela seleção de entidades. O AutoCAD tem várias opções de seleção. Para escolher uma opaco de seleção, digite na linha de comando as letras em maiúscula da opção que se pretende.

· Point (Ponto)

Se a um ponto assinalado na tela corresponde uma entidade, ela será selecionada.

· All (Tudo)

Seleciona todos os objetos de um desenho.

· Window (Janela)

Seleciona um grupo de objetos que estejam totalmente inseridos em uma janela (window) definida por 2 pontos em linha contínua.

· Crossing (Interseção)

Seleciona todas as entidades que estão total ou parcialmente inseridas em uma janela do tipo crossing definida por 2 pontos em linha tracejada.

· Box (Caixa)

Permite que se escolha entre os dois métodos de seleção acima de acordo com se desenha a janela. Se o 2º ponto se encontra a direita do primeiro e uma seleção por window. Mas, se o 2º ponto se encontra a esquerda do primeiro e uma seleção por crossing. 

· Wpolygon (Janela Poligonal)

Seleciona um grupo de objetos que estejam totalmente inseridos em uma janela poligonal de “n” pontos.

· Cpolygon 
Seleciona todas as entidades que estão total ou parcialmente inseridas em uma janela do tipo crossing definida por “n” pontos em linha tracejada.

· Fence (Cerca)

Seleciona todos os objetos que estão cortados por uma linha.

· Last (Último)

Seleciona apenas a última entidade criada em um desenho.

· Previous (Anterior)

Seleciona todas as entidades previamente selecionadas com o comando select, do qual vamos falar em seguida.

· Undo (U) (Desfazer)

Desfaz a última seleção.

· Remove (R) (Remover)

Sempre que queira retirar uma ou mais entidades de uma seleção, utilize a opção remove e indique as entidades a remover.                            

· Add (Adicionar)

Quando já não quiser remover mais entidades da seleção e quiser adicionar outras, utilize a opção add.

· Select (Selecionar)

Permite ao usuário selecionar primeiro os objetos que pretende editar, e, só depois, chamar o comando pretendido.

Command: Select (enter)

Select objects: W (ou outro modo de seleção)

Command: Erase (ou outro comando)

Select objects: P

· Ddselect (Opções de Seleção)

Controla o modo de seleção através de uma caixa de diálogo.

Command: Ddselect (enter)

ou

Tools => Selection

8. Comandos Auxiliares de Desenho

· Osnap

O Comando Osnap permite ao usuário realizar desenhos com precisão. 

As opções deste comando são acessadas através da Standard toolbar, ou utilizando-se os bottons menu pressionando juntas as teclas Shift e o botão direito do mouse, outra forma de acessar é digitando Osnap na linha de comando.

O comando Ddosnap ativa uma caixa de diálogo que nos permite controlar a abertura do quadrado associado a indicação do mouse (aperture size), os modos Osnap pretendidos e o Autosnap.
Command: Ddosnap (enter)

ou

Tools => Object Snap Settings

As opções do comando Osnap são:

· ENDpoint:
Localiza o ponto final de uma linha, polyline, arco, etc.

· MIDpoint:

Localiza o ponto médio de uma linha, polyline, arco, etc.

· CENter:

Localiza o centro de um círculo, arco, elipse, solid ou arco elíptico.

· NODE:

Possibilita a localização de um ponto gerado pelo comando Point.

· Quadrant:

Localiza o quadrante de um arco, círculo, elipse, solid ou arco elíptico. Os quadrante são as posições de 0, 90, 180 e 270 graus.

· INTersection:
Localiza a interseção de duas entidades tais como linhas, arcos, polylines, etc.

· INSertion:
Localiza o ponto de inserção de um texto ou de um bloco.

· PERpendicular:

Possibilita a geração de perpendiculares a um arco, linha, mline, círculo, elipse, etc.

· TANgent:

Localiza com relação ao último ponto, a tangência com um círculo ou arco. 

· NEArest:

Localiza o ponto mais próximo de uma entidade qualquer, dentro da área de ação do comando.

· APParent Int:

Localiza o ponto de interseção de duas entidades que podem ou não estar se interceptando. 

· Parallel:
Cria uma reta paralela a outra.

· AutoSnap

O AutoCAD, a parir de sua versão14, trouxe um novo modo de snap chamado AutoSnap. Através dele o usuário pode pre-visualizar e confirmar os pontos críticos das entidades antes de selecionar o ponto pretendido durante as operações de edição e de desenho.

· Grid (Grade)

Cria uma grade de pontos, com qualquer espaçamento, que serve como referencial fornecendo um sistema de coordenadas visuais num desenho. Esta grade vai permitir ao usuário estimar o tamanho das entidades do desenho e as suas relações.

Command: Grid (enter)

Grid spacing (x) or ON/OFF/SNAP/ASPECT<CURRENT>: Aspect (enter)

Horizontal spacing (x) <0.00>: 10 (enter)

Vertical spacing (x) <0.00>: 5 (enter)

· Grid spacing:

Ajusta e ativa o valor dos espaçamento da grade (sendo x=y).

· ON:

Ativa a grade.

· OFF:

Desativa a grade.

· Snap: 

Torna o espaçamento da grade de pontos igual ao espaçamento da grade de saltos.

· Aspect:

Usando esta opção você pode construir uma grade com diferentes espaçamentos em x e em y.

· Obs.:

Se pressionar a tecla F7, você ativa ou desativa a grade automaticamente. Se o espaçamento for muito apertado para a área dos limites do desenho, o AutoCAD não a coloca e responde: Grid too dense to display.
· Snap

Pontos introduzidos por meio do mouse ficam restringidos a uma grade retangular invisível pelo mecanismo snap. Todas as coordenadas que entrarem são fixadas ao ponto mais próximo da grade, caso o modo snap esteja ligado.

Command: Snap (enter)

Snap spacing or ON/OFF/Aspect/Rotate/Style <current>:

· Snap spacing:
Respondendo com um valor numérico, o modo snap será ativado com este valor como resolução da grade. 

· ON:

Ativa o modo snap.

· OFF:



Desativa o modo snap.

· Aspect:

Ajusta diferentes incrementos de salto horizontal (eixo x) e vertical (eixo y).

· Rotate:

Rotaciona a grade snap em relação ao desenho e a tela, ou coloca a grade snap num outro ponto base diferente de 0,0.

· Style:

Permite optar entre dois estilos de grades diferentes: o standard que é um estilo retangular, e o isometric que coloca na tela uma grade de orientação isométrica.

· Obs.:

Pressionando a tecla F9 o modo snap é ativado e desativado automaticamente.

· Ortho:

Determina que todas as retas desenhadas sejam ortogonais. Pressionando a tecla F8 ativa e desativa automaticamente o modo ortho.

9. Como Manipular as Entidades do Desenho

· Copy (Copiar)

Copia objetos existentes.

Command: Copy (enter)

Select objects: (selecione os objetos na tela) (enter)
<Base point or displacement> /Multiple: (clique sobre um ponto de base) (enter)



Second point of displacement: (clique sobre um ponto onde 

você queira localizar a cópia) (enter)


Obs.: também podemos selecionar este comando através da 


Toolbar modify.

· Move (Mover)
Move uma ou mais entidades de uma posição a outra, sem que haja alteração da sua orientação ou tamanho.

Command: M (enter)

Select objects: 

<Base point or displacement>:(ponto de base ou deslocamento)

Second point of displacement: (2º ponto do deslocamento)



Obs.: também podemos selecionar este comando através da 


Toolbar modify.

· Rotate (Rotacionar)

Rotaciona entidades sobre um determinado ponto de base.

Command: Rotate (enter)

Select objects: 

Base point: (ponto de base)

<Rotation angle>/ Reference: (ângulo de rotação)



Obs.: também podemos selecionar este comando através da 


Toolbar modify.

· Scale (Escalar)

Altera a escala de entidades do desenho. Se o fator de escala for >1 haverá aumento no tamanho das entidades; caso contrário elas diminuirão. A mudança de tamanho ocorre em relação a um ponto base.

Command: Scale (enter)

Select objects:

Base point: (ponto de base)

<Scale factor>/ Reference: (fator de escala)



Obs.: também podemos selecionar este comando através da 


Toolbar modify.

· Mirror (Espelhar)

Permite ao usuário obter imagens simétricas refletidas (efeito de espelho) de objetos existentes; com a opção de manter ou eliminar os objetos originais. Cria-se um eixo de reflexão para permitir que os objetos sejam espelhados em qualquer ângulo desejado.

Command: Mirror (enter)

Select objects:

First point of mirror line: (1º ponto da linha de eixo)

Second point of mirror line: (2º ponto da linha de eixo)

Delete old objects? <N> (enter) (não apaga o objeto original)



Obs.: também podemos selecionar este comando através da 


Toolbar modify.

· Array (Cópias múltiplas ordenadas) 

Permite que se faca múltiplas cópias de objetos selecionados em padrões circulares (polar) ou retangulares. Cada objeto resultante pode ser manipulado independentemente.

· Array Rectangular

Command: Array (enter)

Select objects:

Rectangular ou Polar array (R/P) <R>: (enter)

Number of rows (-----)<1>: (número de linhas)

Number of columns (|||) <1>: (número de colunas)

Distance between rows (-----): (distância entre as linhas)

Distance between columns (|||):(distância entre as colunas)

· Array Polar

Command: Array (enter)

Select objects:

Rectangular ou Polar array (R/P) <P>: (enter)

Center point of array: (ponto central – polo do array)

Number of itens (-----)<1>: (número de itens)

Angle to fill (+=CCW, -=CW) <360>: (ângulo de varredura)

Rotate objects as they are copied? <Y>: (rotacionar os objetos a medida que estes são copiados?)

Obs.: Para obter um resultado com direção contrária, deverão ser dados valores negativos as distâncias entre os objetos.

Obs. 2: também podemos selecionar este comando através da 


Toolbar modify.

10. Como Alterar as Entidades do Desenho

· Break (Quebrar)

Apaga parte de uma entidade linear ou circular, ou parte uma entidade em duas do mesmo tipo provocando um ponto de descontinuidade.

Command: Break (enter)

Select objects:

Enter second point (or F for first point): (entre o 2º ponto ou a letra F para selecionar o 1º ponto)

Obs. 1: se ao invés de clicarmos em um segundo ponto digitarmos @ significa que o 1º e coincidente com o 2º e partimos a entidade em duas.



Obs. 2: também podemos selecionar este comando através da 


Toolbar modify.

· Trim (Cortar)

Permite cortar entidades a partir de outras com as quais estas apresentem interseção. As entidades cortadas serão podadas no ponto de interseção com as entidades ditas cortantes.

Command: Trim (enter)

Select cutting edge(s)… (Projemode = UCS, Edgmode = Extend) (selecione as entidades cortantes)

Select objects: (enter) (termina a seleção de entidades cortantes)

<Select object to trim> Project/Edge/Undo: (selecione os objetos a serem cortados)



Obs.: também podemos selecionar este comando através da 


Toolbar modify.

· Extend (Estender)

Estende entidades do desenho de modo que termine precisamente sobre outras previamente definidas como limite.

Command: Extend (enter)

Select boundary edge(s)… (Projmode = UCS, Edgmode = extend) (selecione os limites da extensão) 

Select objects: (enter) (termina a seleção dos limites da extensão)

<Select object to extend> Project/ Edge/ Undo: (selecione os objetos a serem estendidos)

<Select object to extend> Project/ Edge/ Undo: (enter) (finaliza o comando)



Obs.: também podemos selecionar este comando através da 


Toolbar modify.

· Fillet: (Bolear)

Faz a concordância entre duas entidades (linhas, arcos, círculos) através de um arco de raio especificado. Se o raio corrente é zero, as duas entidades serão estendidas ou aparadas na interseção aparente ou real das mesmas.

Command: Fillet (enter)

Polyline/ Radius/ Trim/ <Select two objects>: (selecione um objeto)

Select second object: (selecione o segundo objeto)

Para mudar o raio de arredondamento deve-se proceder:

Command: Fillet (enter)

Polyline/ Radius/ Trim/ <Select two objects>:R (enter) 

Enter fillet radius <0.000>: (digite um valor para o raio)

Para arredondar polylines:

Command: Fillet (enter)

Polyline/ Radius/ Trim/ <Select two objects>:P (enter) 

Select 2D Polyline: (selecione uma polyline)

“n” lines were filleted


Obs.: também podemos selecionar este comando através da 


Toolbar modify.

· Stretch (Esticar)

Possibilita o deslocamento de uma ou mais extremidades de um desenho, mantendo as ligações que estas tenham com outras entidades não selecionadas pelo comando.

Command: Stretch (enter)

Select objects to stretch by window or polygon… (selecione os objetos a serem esticados usando uma janela ou um polígono)

Select objects:

Base point or displacement: (selecione o ponto de base)

Second point of displacement: (2º ponto do deslocamento)

Obs. 1: A janela ou polígono de seleção devem ser no modo crossing.



Obs. 2: também podemos selecionar este comando através da 


Toolbar modify.

11. Comandos de Desenho

· Circle (Círculo)

Apresenta 5 maneiras diferentes de gerar um círculo. Por default, o AutoCAD desenha o círculo pedindo 1º o centro e depois o raio.

1º) Center/ Radius - dados: centro e raio;

2º) Center/ Diameter - dados: centro e diâmetro;

3º) 2 Point - dados: 2 pontos;

4º) 3 Point - dados: 3 pontos;

5º) Tan/ Tan/ Radius- dados: 2tangentes e raio;

6o)Tan/Tan/Tan – dados: 3 tangentes.

Command: Circle (enter)

3P/2P/TTR/ <Center point>:

Obs.: também podemos selecionar este comando através da Toolbar Draw.

· Arc (Arco)

O AutoCAD oferece 11 possibilidades para se desenhar um arco. Com exceção do método de geração de arco por 3 pontos, os demais sempre irão desenhá-los no sentido anti-horário em relação ao ponto inicial. Se o ângulo especificado for negativo, o arco é desenhado no sentido horário. O sentido positivo para contagem de ângulo também é o anti-horário.

1º) 3points – dados: 3 pontos;

2º) Start/ Center/ End – dados: início, centro e fim;

3º) Start/ Center/ Angle – dados: início, centro e ângulo; 

4º) Start/ Center/Length – dados: início, centro e comprimento 

      da corda;

5º) Start/ End/ Angle – dados: início, fim e ângulo; 
6º) Start/ End/ Direction – dados: início, fim e direção; 

7º) Start/ End/ Radius – dados: início, fim e raio;
8º) Center/ Start/ End – dados: centro, início e fim;
9º) Center/ Start/ Angle – dados: centro , início e ângulo;
10º) Center/ Start/ Length – dados: centro , início e comprimento 

      da corda;

11º) Continue – dá continuidade ao arco anterior.
Command: Arc (enter)

Center/ <Start point>: (escolhemos um ponto na tela) (enter)

Center/ End/ <Second point>: (escolhemos outro ponto) (enter)

 End point: (escolhemos o terceiro ponto) (enter) 

Obs. 1: por default, o AutoCAD desenha o Arco por 3 pontos.

Obs. 2: também podemos selecionar este comando através da Toolbar Draw.

· Ellipse (Elipse)

Uma elipse pode ser desenhada de 3 maneiras diferentes:

1º) Axis – dados: os dois eixos;

2º) Center/ 2 Axis – dados: centro e dois eixos;

3º) Rotation– dados: ao invés de se determinar o 2º eixo pode-se  

     defini-lo especificando a rotação de um círculo sobre o eixo 

     maior (o ângulo de rotação pode variar de 0º a 89,4º).

Command: Ellipse (enter)

Arc/ Center/ Isocircle/ <Axis endpoint>: (clica num ponto) (enter)

<Other axis distance>/Rotation: (um ponto ou valor) (enter)

Obs. 1: a opção Arc permite desenhar arcos elípticos.

Obs. 2: a opção Isometric é mostrada quando se trabalha no 

modo Snap isométrico.

Obs. 3: também podemos selecionar este comando através da Toolbar Draw.

· Donut 

Este comando desenha círculos cheios (filled circles) e anéis cheios (rings).

Command: Donut (enter)

Inside diameter <current>: (valor) (enter)

Outside diameter <current>: (valor) (enter)

Center of doughnut: (ponto na tela) (enter)

Este comando apresenta 2 opções: 

· Fill on: interior preenchido

· Fill off: interior vazio

Obs. 1: também podemos selecionar este comando através da Toolbar Draw.

· Rectang (Retângulo)

Desenha retângulos definidos através de 2 vértices.

Command: Rectang (enter)

From corner: 1º vértice (enter)

Other corner: vértice diagonalmente oposto ao 1º (enter)

· Polygon (Polígono)

Permite ao usuário desenhar polígonos regulares de 3 a 1024 lados.

Command: Polygon (enter)

Number of sides <4>: (número de lados) (enter)

Edge/ <center of polygon>: (determina o centro do polígono ou escolhe a opção Edge - lado) (enter)

Inscribed in circle/ Circunscribed about circle (I/C) <I>: (aceita inscrito) (enter)

Radius of circle: (valor do raio) (enter)

Obs. 1: também podemos selecionar este comando através da Toolbar Draw.

· Point (Ponto)

Desenha pontos na tela. A forma e o tamanho dos pontos são controladas através das variáveis Pdmode e Pdsize. Podemos controlar estas variáveis através do menu pull-down Format => point style ou simplesmente digitando-as no prompt Command.
Estes pontos podem ser capturados com a ajuda do Node do comando Osnap.

Command: Point (enter)

Point: (clica sobre um ponto na tela) (enter)

Obs. 1: também podemos selecionar este comando através da Toolbar Draw.

· Pline (Polilinha)

Desenha uma seqüência conectada de segmentos de linha e de arco, sendo visto pelo AutoCAD como uma entidade única. A polilinha pode ser desenhada por linha cheia, pontilhada ou tracejada; pode-se atribuir diferentes espessuras as linhas e arcos que compõem uma polilinha. Pode-se inserir, mover ou deletar vértices; pode-se unir várias linhas arcos e polilinhas em uma única polilinha.

Command: Pline (enter)

From point: (clica sobre um ponto na tela) (enter)

Arc/ Close/ Halfwidth/ Length/ Undo/ Width/ <Endpoint of line>: (outro ponto) (enter)

1º) <Endpoint of line>: é a opção default; ponto final de um 

      segmento de linha.

2º) Arc: passa para o modo Arc (arco).

3º) Close: desenha uma linha da posição corrente a posição 

      inicial da polilinha, gerando assim uma polilinha fechada.

4º) Halfwidth: permite que se especifique a espessura do ponto

      mediano de um segmento da polilinha.

5º) Length: desenha um segmento de linha no mesmo sentido do

      segmento anterior; se este for um arco, produz-se um 

      segmento de linha tangente a este arco.

6º) Undo: remove o último segmento desenhado. 

7º) Width: permite que se especifique a espessura do segmento 

                 mediano de um segmento da polilinha.

                                       starting width <0,000>: (valor) (enter)

                                       ending width <0,000>: (valor) (enter)

                                       a espessura torna-se default até que nova

                                       modificação seja feita.
Obs. 1: também podemos selecionar este comando através da Toolbar Draw.

· Spline

Permite desenhar uma linha curva e ajustável através de um conjunto de pontos dados. Este comando é especialmente útil para criar superfícies curvas irregulares como, por exemplo, curvas de nível .

Command: Spline (enter)

Object/<Enter first point>: (ponto 01) (enter)

Enter point: (ponto 02) (enter)

Close/ Fit tolerance/<Enter point>: (ponto 03) (enter)

Close/ Fit tolerance/<Enter point>: (ponto 04) (enter)

Close/ Fit tolerance/<Enter point>: (ponto 05) (enter)

Close/ Fit tolerance/<Enter point>: (ponto 06) (enter)

Close/ Fit tolerance/<Enter point>: (enter)

Enter start tangent: (enter)

Enter end tangent: (enter)

Obs. 1: também podemos selecionar este comando através da Toolbar Draw.

Para editar uma Spline utilize o comando Splinedit:

Command: Splinedit (enter)

Select spline: (selecione uma spline) (enter)

Fit Data/ Close/ Move Vertex/ Refine/ rEverse/ Undo/ eXit <x>: (selecione uma das opções) (enter)

Obs. 2: também podemos selecionar o comando Splinedit através da Toolbar Modify.

12. Comandos de Texto

As entidades de texto são tratadas da mesma forma que qualquer outra entidade e são desenhadas com um determinado estilo (Style). Com um mesmo estilo, podem ser criados textos de diversas formas como, por exemplo, alinhado, centralizado, etc. As características básicas das letras pertencentes a um estilo são determinadas pelo caracter modelo (Fonts) que ele adota e para modificá-las, é necessário redefinir novamente o estilo ou criar um novo estilo (opção Style).

· Dtext (Texto dinâmico)

Command: Text (enter)

[Justify/ Style] <Start point>: (clica num ponto na tela) (enter)

Se respondermos Justify podemos escolher entre diversas formas de criar o texto:

· Align: pede 2 pontos e ajusta o tamanho dos caracteres para

                      que o texto fique entre estes 2 pontos, alterando inclusive a 

                      altura dos caracteres.

· Fit: similar a opção Align, a diferença é que esta opção fixa a altura especificada e só ajusta a largura dos caracteres aos 2 pontos especificados.

· Center: pede 1 ponto para ser o centro horizontal do texto, o tamanho dos caracteres são ajustados em proporção a altura especificada.

· Middle: similar a opção Center, a diferença é que esta opção ajusta o texto em relação ao ponto especificado tanto horizontalmente como verticalmente.

· Right: determina o ponto mais a direita do texto.

As outras justificações possíveis são:

· TL – Top Left (Alinha o texto por baixo e pela esquerda)

· TC – Top Center (Alinha o texto por cima e pelo centro)

· TR – Top Right  (Alinha o texto por cima e pela direita)

· ML – Middle Left (Alinha o texto pelo meio e pela esquerda)

· MC – Middle Center (Alinha o texto pelo meio e pelo centro)

· MR – Middle Right (Alinha o texto pelo meio e pela direita)

· BL – Bottom Left (Alinha o texto por baixo e pela esquerda)

· BC – Bottom Center (Alinha o texto por baixo e pelo centro)

· BR – Bottom Right (Alinha o texto por baixo e pela direita)

Style – permite modificar o estilo do texto a ser escrito. O padrão é que seja sempre escrito no estilo de texto corrente.

Obs. 1: para introduzir texto em várias linhas num mesmo alinhamento é só pressionar enter depois do último texto introduzido. 

Obs. 2: também podemos selecionar este comando através da Toolbar Draw.

· Style (Estilo)

O comando Style permite selecionar um determinado estilo de letra, redefinir um estilo de letra, ou então criar um novo estilo de letra. As características de um estilo são definidas pelo seu caracter modelo Fonte (Fonts).

Command: Style (enter)

Surge na tela a caixa de diálogo Text Style;

Para criar um novo estilo utilizamos a opção New;

Uma fonte de texto é composta pelos seguintes elementos:

· Style Name: nome, dado pelo AutoCAD ou pelo usuário, até 31 caracteres.

· Font name: nome da fonte de texto associada.

· Height: altura do texto fixa ou igual a 0 (zero).

· Width Factor: fator de escala para a largura (expansão/ compressão)

· Oblique Angle: o ângulo de obliqüidade.

· Backwards: um indicador de escrita no sentido inverso.

· Upside down: um indicador de escrita invertida.

· Vertical: um indicador de orientação, vertical ou horizontal.

Obs.: também podemos selecionar este comando através do menu pull-down Format: Format => Text Style.

· Qtext (Texto rápido)

Este comando permite ao usuário controlar a forma como o texto é visualizado e escrito na tela.

Command: Qtext (enter)

ON/OFF <current>: OFF (ou ON para ativar) (enter)

· Mtext (Texto em parágrafo)

Cria um texto em parágrafo dentro de um limite definido pelo usuário. Este limite é um retângulo que especifica a largura e alinhamento do parágrafo. Cada conjunto de texto, criado através do comando Mtext, funciona como uma entidade única e o retângulo que define os limites do texto nunca é impresso.

Command: Mtext (enter)

Specify first corner: (clica em um ponto que será o 1º canto do retângulo que especifica os limites) (enter)

Specify opposite corner [Height/ Justify/ Rotation/ Style/ Width]: : (clica em um ponto que será o 2º canto do retângulo que especifica os limites) (enter)

As opções do comando Mtext são as seguintes:

· Height: define a altura do texto (através das maiúsculas).

· Justify: define que parte dos limites do texto alinham pelo ponto de inserção.

· Rotation: define o ângulo de rotação dos limites do texto.

· Style: define o estilo do texto em parágrafo.

· Width: define a largura dos limites do texto

Obs.: também podemos selecionar este comando através da Toolbar Draw.

· Ddedit (Edição de texto)

Edita uma linha de texto anteriormente definida permitindo alterar seu conteúdo.

Obs.: pode usar o comando Undo, após a alteração do texto, recuperando, assim, a mensagem inicial.

Command: Ddedit (enter)

<Select an annotation object or [Undo]: (selecione um texto) (enter)

Obs.: se o texto selecionado pelo comando Ddedit for Mtext, é aberta a caixa de diálogo: Multiline Text Editor.

· Importação de Textos

Uma das maneiras de importar textos é através da opção Import da caixa de diálogo Multiline Text Editor.

Clique no arquivo de texto a copiar e clique em Import.

O arquivo de texto importado deve ter sua fonte selecionada em Font evitando assim a ocorrência de erros.

13. O Comando Help

O comando help (ajuda) pode ser acessado de diversas formas. Uma delas é digitando:

Command: help

ou

Command: ?

Uma outra maneira é pressionar a tecla F1, outra é utilizar o menu pull-down Help, ou então clicar sobre o ícone ? da Standard toolbar:

· Tópicos da Ajuda: AutoCAD Help 

Explica comandos e funcionalidades do AutoCAD. Itens: Conteúdo, Índice e Localizar.

· AutoCAD 2000 Readme

Dá recomendações básicas sobre o hardware necessário, bem como sobre a instalação e desinstalação do AutoCAD. Encontra-se em Conteúdo.

· What’s New in AutoCAD 2000

Indica quais são os novos comandos e características do AutoCAD 2000.

Como o help é um comando transparente, o AutoCAD nos dá a possibilidade de utilizá-lo durante a execução de um comando.

14. A Gestão do Desenho por Camadas (Layers)

· Layer (Camada)
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Os níveis de trabalho (Layers) constituem uma forma de organizar o desenho em várias camadas transparentes e superpostas, as quais permitem separar cada grupo de entidades relacionadas numa delas e trabalhar com cada nível individualmente. Podemos ainda atribuir propriedades a essas camadas, cor e tipo de linha, que serão assimiladas pelas entidades.

Onde Encontrar: Menu Format ou Command: Layer ou Ddlmodes (enter)

Current - Mostra o Layer ativo no momento, em que todas as entidades desenhadas a partir de agora estarão. Para selecionar um novo Layer corrente, clique no nome do Layer e depois em Current.

Quadro de Controle - Este quadro mostra o nome do Layer, o seu estado e suas propriedades. O Layer 0 (zero) é o default do AutoCAD e não pode ser apagado ou renomeado. Os estados do Layer podem ser:

· On / Off (lâmpada) - Liga e desliga o Layer na tela. Quando desligado, Layer não se apresenta na tela, mas continua regenerando com os outros. Além disso, sofre as alterações dos comandos de edição desde que sejam selecionados todos os objetos (ALL).

· Thaw / Freeze (sol) - Congela e descongela um Layer. Quando congelado, o Layer não é mostrado e também não conta para regeneração. Os objetos dos Layers congelados não sofrem alterações.

· Lock / Unlock (cadeado)- Trava e destrava um Layer. Um Layer travado aparece na tela, mas apenas como referência, não podendo ser editado.

As propriedades são:

· Color – Define  a cor de um Layer. Todas as entidades desenhadas naquele Layer (com a propriedade Color ajustada para BYLAYER) serão apresentadas com esta cor. Quando modificamos a cor, as entidades mudam automaticamente.

· Linetype - Permite modificarmos o tipo de linha das entidades desenhadas naquele Layer. Antes de modificarmos o tipo de linha é necessário, entretanto, carregar os tipos de linha desejados no comando Linetype.

· Lineweight – Permite determinar a espessura em que a linha será impressa.

New - Cria um novo layer. Clicando-se neste botão, um retângulo aparecerá no quadro de controle, permitindo que seja dado um nome, de até 32 caracteres, ao novo Layer.

Delete – Apaga o Layer selecionado.

Layer Control
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Esta nova ferramenta encontra-se na Toolbar Object Properties ao lado do ícone de Layers. Ela permite mudanças no estado dos Layers sem a necessidade de ativar o comando Layer, além de permitir ajustar rapidamente um novo Layer, bastando clicar no nome desejado. Permite também, modificar o Layer de objetos. Para isso, seleciona-se os objetos através dos GRIPS e depois clica-se no nome do novo Layer desejado.

Make Object’s layer Current
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Este comando faz com que o Layer do objeto selecionado passe a ser o Layer corrente.

Color
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Permite modificar a cor ativa no desenho, ou seja, permite definir a cor de todas as novas entidades.

Bylayer – É a opção padrão. Com esta opção, os objetos sempre terão a cor do Layer a que pertencerem.

Byblock– Esta opção desenha os novos objetos na cor padrão (branco ou preto, dependendo da sua configuração). Quando este objeto é agrupado num bloco e este bloco é inserido no desenho, tal objeto assumirá a cor corrente definida no comando COLOR.

Obs. 1: O Layer 0 já existe por default .

Obs. 2: Para congelar um Layer este não pode ser o corrente.

· Purge

O comando Purge permite remover do desenho corrente objetos a ele associados (Layers, Blocos, etc.), mas que já não estão sendo utilizados.

Command: Purge (enter)

15. Como Alterar as Propriedade das Entidades

· Change (Alterar)

Este comando permite modificar as características de entidades como linhas, círculos, textos, blocos, ou modificar as propriedades comuns a qualquer tipo de entidade de desenho como, por exemplo: Cor, Layer, Tipo de Linha, etc.

Command: Change (enter)

Select objects: (selecione os objetos a serem alterados) (enter)

Properties/<Change point>: (clica em um ponto) ou P (enter)

Obs. 1: A opção Elev permite alterar a elevação das entidades selecionadas, o que significa alterar as suas coordenadas em relação ao eixo Z. Elev está disponível através da opção Properties. 

Command: Change (enter)

Select objects: (selecione os objetos a serem alterados) (enter)

Properties/<Change point>: P (enter)

Change what property (Color/ Elev/ Layer/ Ltype/ ltScale/ Thickness) ?: [Cor/ Elevação/ Camada/ Tipo de Linha/ Escala da Linha/ Espessura]

Obs. 2: Também podemos selecionar este comando através do Modify toolbar.

· Chprop (Alterar Propriedades)

Permite modificar as propriedades comuns a qualquer tipo de entidade de desenho. Estas propriedades são: 

· Color (Cor)

· Layer (Camada)

· Ltype (Tipo de linha)

· LtScale (Escala da linha)

· Thickness (Espessura)

Command: Chprop (enter)

Select objects: (selecione os objetos a serem alterados) (enter)

Change what property (Color/ Layer/ Ltype/ ltScale/ Thickness) ?:

· Ddchprop (Alterar Propriedades com caixa de diálogo)
Permite modificar as propriedades das entidades através de uma caixa de diálogo.

Command: Ddchprop (enter)

Select objects: (selecione os objetos a serem alterados) (enter)

· Ddmodify (Modificar com caixa de diálogo)
Permite ao usuário modificar as propriedades de uma entidade de desenho através de caixas de diálogo. 

Command: Ddmodify (enter)

Select object to modify: (selec. objeto a ser modificado) (enter)

Obs. 1: permite a seleção de uma única entidade.

Obs. 2: também podemos selecionar este comando através do Object Properties toolbar

· Match Properties (Casar propriedades)
Permite copiar as propriedades de um objeto para outro de uma forma rápida e amigável. Para selecionar este comando, utilizamos o seu ícone que se encontra na Standard Toolbar.

Select Source Object: (selecionar objeto de onde se quer copiar propriedades) (enter)

Settings/ <Select Destination Object(s)>: (selecionar objeto(s) que vão ter suas propriedades alteradas) (enter)

A opção Settings abre uma caixa de diálogo que permite indicar que tipo de propriedades são copiadas.

· Linetype (Tipo de Linha)

É usado para modificar o tipo de linha usado na representação das entidades. 

O AutoCAD traz consigo uma biblioteca standard  contendo vários tipos de linha (AutoCAD Standard Linetypes).

Command: Linetype (enter)

Obs.: também podemos selecionar este comando através do  menu pull-down Format.

· Ltscale (Escala da Linha)

A relação entre as partes constituintes de qualquer tipo de linha e feita em termos de unidades de desenho. Este comando permite ajustar a constituição da linha alterando seu valor de escala.

Command: Ltscale (enter)

New scale factor <default>: (fator de escala) (enter)

16. Mais Comandos de Edição

· Undo (Desfazer) e Redo (Refazer)

O AutoCAD utiliza um processo de escrita em memória que permite criar uma relação de todos os comandos executados. Assim, é possível regredir e anular comandos pela ordem inversa a que foram executados.

Command: U ou Undo (enter)

Se quiser anular a ultima ação do comando Undo, utilize, logo a seguir a este comando, o comando Redo.

Command: Redo (enter)

Também podemos utilizar a Standard Toolbar para selecionar os comando Undo e Redo.

· Pedit (Editar polilinhas)



Permite ao usuário editar os objetos criados com polilinhas.



Command: Pedit (enter)



Select polilyne: (selecione uma polilinha) (enter)

Se a entidade selecionada não for uma polilinha, o comando pergunta-lhe:

Entity selected is not a polyline.

Do you want it to turn into one? <Y> (enter) (aceita a opaco por default, que transforma em polilinha a entidade selecionada)

[Close/ Join/ Width/ Edit-vertex/ Fit/ Spline/ Decurve/ Ltype gen/ Undo] :

· Close: fecha a polilinha.

· Join: possibilita a junção de entidades (linhas, arcos ou outras polilinhas) a uma polilinha desde que estas entidades tenham um ponto em comum.

· Width: permite a alteração uniforme da espessura de uma polilinha .

· Fit: permite que uma polilinha reta passe a ser curva.

· Spline: permite que uma polilinha reta passe a ser curva através do método B-spline.

· Decurve: anula os efeitos do comando Fit e Spline.

· Undo: anula a mais recente edição feita pelo comando Pedit.

· eXit: pressione X ou Ctrl-C para sair do comando.

· Edit Vertex: e responsável pela edição de vértices individuais e seus segmentos associados:

· Next e Previous: e através desses dois comandos que se vai para o vértice que se quer modificar.

· Break: permite a divisão de uma polilinha num determinado vértice, ou a eliminação de um segmento entre dois vértices.

· Insert: possibilita a inclusão de novos vértices.

· Move: permite o deslocamento da posição de um vértice.

Obs.: também podemos utilizar a Modify toolbar para selecionar este comando. 

· Divide (Dividir)


Divide uma entidade num número especificado de partes iguais.



Command: Divide (enter)



Select object to divide: (selecione o objeto a ser dividido) (enter)



<Number of segments>/ Block: (digite no. de segmentos) (enter)

Obs. 1: também podemos selecionar este comando através da Toolbar Draw.

Obs. 2: se você não for capaz de visualizar as marcas da divisão, utilize a opaco Point Style do menu Pull-down Format para escolher uma marca de ponto que se possa visualizar.

· Measure (Medir)
Permite dividir uma entidade em porções definidas em medidas pelo usuário.

Command: Measure (enter)

Select object to Measure: (selecione o objeto) (enter)

<Segment length>/ Block: (digite uma medida) (enter)

Obs. 1: também podemos selecionar este comando através da Toolbar Draw.

17. Obtendo Informações

· List (Listar)

Dá informações das entidades selecionadas no desenho em tela de texto.

Command: List (enter)

Select object: (selecione o objeto) (enter)

Obs.: também podemos selecionar este comando através da Object Properties Toolbar .

· Area (Área)

Calcula a área e o perímetro definidos por uma seqüência de pontos, ou através de uma entidade (por exemplo: círculo, polilinha, etc.)

Command: Area (enter)

<First point>/Object/Add/Subtract:

Obs.: também podemos selecionar este comando através da Object Properties Toolbar .

· Dist (Distância)

Dá a distância e ângulo em relação ao eixo “X” e plano “XY”, entre dois pontos selecionados.

Command: List (enter)

First point: (seleciona o 1º ponto) (enter)

Second point: (seleciona o 2º ponto) (enter)

Obs.: também podemos selecionar este comando através da Object Properties Toolbar .

18. Manipulando entidades com GRIPS e DDGRIPS

· Grips

O AutoCAD permite editar entidades de desenho através da manipulação de GRIPS. Os Grips são pequenos quadrados determinada cor que assinalam os pontos críticos das entidades selecionadas do desenho.

Os GRIPS permitem-nos Mover, Copiar, Apagar, etc. qualquer entidade ou grupo de entidades selecionadas.

Command: GRIPS (enter)

New value for GRIPS<1> (valor 1= Grips ativos) (enter)

· Ddgrips

O comando Ddgrips controla o funcionamento dos Grips através de uma caixa de diálogo. Podemos acessar este comando através do menu pull-down Tools.

· Editar com Grips

Para editar com Grips, é necessário selecionar as entidades de desenho através de uma janela. Isto faz com as entidades selecionadas mostrem os seus pontos críticos através do Grips. Em seguida, você terá que selecionar uma das Grips para funcionar como ponto base do comando de edição pretendido. São varias as operações de edição que se podem realizar. Por default, a primeira é o comando Stretch. 

Dependendo da entidade e da Grip que for selecionada, é possível mover automaticamente a entidade de desenho. Para isso, você só tem que arrastar, com o indicador do mouse, a Grip para uma nova posição.

· O Menu do botão do lado direito do mouse

É possível utilizar um menu de mouse pressionando o botão direito do mouse quando os Grips estão selecionados.

19. Hachuras

· Hatch (Hachurar)

O AutoCAD obriga a delimitar as áreas que se pretendem tracejar através de um contorno fechado e sem pontos de descontinuidade.

Command: Hatch (enter)

Enter pattern name or [?/Solid/User defined ]<default>:

Select object:

· Bhatch
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O comando Bhatch permite hachurar uma determinada área com 69 padrões existentes no programa. Este comando define automaticamente os contornos da área que se pretende hachurar clicando-se com o ponteiro do mouse no interior da mesma.

Onde Encontrar: Command: Bhatch (enter)
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ou

Podemos utilizar o Draw toolbar para selecionar este comando.

Com o Bhatch é possível controlar as várias opções do comando Hatch através de caixas de diálogo.

Type – Este campo definirá o tipo de hachura a ser utilizado.

Pattern - Ativa o quadro que mostra os tipos de hachura prontos. Para escolher um deles, clique no retângulo que o mostra. Pode-se também digitar o nome no retângulo do quadro anterior. Esta opção só está ativa quando se utiliza o tipo de hachura Predefined.

Swatch – Mostra os padrões prontos. Pode-se definir qual padrão será utilizado através da opção Pattern.

Custom Pattern - É o chamado padrão definido pelo usuário, 

Angle - Define o ângulo de rotação do padrão.

Scale – Define um fator de escala 

Pick Points - Permite a seleção da área através de um clique no interior de uma área fechada por entidades, perto de uma das bordas. O programa achará automaticamente a área a ser hachurada.

· Select Objects - Permite a seleção de entidades fechadas (polilinhas, polígonos, círculos, etc.) para serem hachuradas.

· Remove Islands – Esta opção volta a tela gráfica para que sejam retiradas da seleção “ilhas” (objetos dentro de outros) automaticamente selecionadas pelo programa, mas que não interessam ao usuário.

· View Selection – Mostra, na tela gráfica, quais áreas foram selecionadas para serem hachuradas.

Advanced – Esta opção abre um quadro de diálogos que define como o AutoCAD procurará as fronteiras a serem hachuradas. Neste quadro é possível escolher entre a opção de detecção automática de ilhas ou não.

Preview Hatch - Permite a visualização da hachura antes de ser aplicada. Caso não esteja satisfatória, basta voltar ao quadro de Hatch Properties e modificar suas propriedades.

Inherit Properties - Volta a tela gráfica para que se possa escolher uma hachura já desenhada, da qual se deseja copiar as propriedades.

Associative – Com esta opção ligada, a hachura fica associada a suas barreiras se adaptando a medida em que estas são editadas.

Explode - O hatch funciona como um bloco inserido no desenho, ou seja, uma só entidade. Essa opção permite que a hachura seja transformada nas entidades que a compõe (linhas, polilinhas, points, etc)

· Hatchedit (Edição de hachuras)

Este comando permite modificar um bloco de padrão de hachura do desenho.

Command: Hatchedit (enter)

Select hatch objects: (selecione a hachura a ser editada) (enter)

Em seguida aparece uma caixa de diálogo com várias opções.

· Bpoly

Este comando permite criar um conjunto de polilinhas fechadas, a partir de uma região fechada.

Command: Bpoly (enter)

Em seguida aparece uma caixa de diálogo com várias opções.

Obs.: podemos usar este comando para delimitar melhor as áreas que pretendemos preencher com hachura.

20. Multilinhas

· Mline (Multilinha) 

Este comando permite desenhar automaticamente segmentos de linha paralelos e controlar a sua escala, estilo e justificação.

Command: Mline (enter)

Justification= Top, Scale= 1.00, Style= Standard

Justification/Scale/ Style/ <From point>: (ponto ou opção) (enter)

Se escolher a opcao Style, pode escolher um estilo para as multilinhas.

Podemos utilizar o Draw toolbar para selecionar este comando.

· Mledit (Edição de Multilinha)

Este comando permite não só controlar o tipo de interseção desejado para as multilinhas (em cruz, em canto, etc.), como também controlar os seus vértices e introduzir (ou retirar) novas aberturas.

Command: Mledit (enter)

Você também pode selecionar este comando através da Modify toolbar.

· Mlstyle (Estilo da Multilinha)

Permite criar e gravar vários estilos de multilinhas com características diferentes para mais tarde utiliza-las no desenho. 

Command: Mlstyle (enter)

Você também pode selecionar este comando através da Object Properties toolbar.

21. Trabalhar com Símbolos Repetitivos

O AutoCAD permite agrupar um conjunto com entidades distintas de forma a constituírem um bloco. A cada bloco esta associado um nome, uma lista das entidades constituintes e um ponto de inserção “insertion base point”. Uma vez definido, o bloco pode ser guardado numa biblioteca de símbolos para utilização em desenhos posteriores. A duplicação de um bloco será feita indicando a nova posição do ponto de referência, a rotação em torno daquela posição e a nova escala.

Uma vez definido um bloco, este passa a constituir uma entidade geométrica de base, sendo possível alterá-lo através de qualquer dos comandos de edição (Erase, Copy, etc.).

Um bloco pode ser constituído por entidades pertencentes a diferentes Layers. A informação referente aos diferentes Layers é preservada na definição do bloco. Isto é, em cada nova duplicação do bloco, cada um dos seus elementos constituintes é associado ao Layer original.

Um bloco pode conter outros blocos na sua definição, são os chamados “Nested Blocks”.

Criando uma Biblioteca: chamamos de biblioteca um conjunto de blocos desenhados no AutoCAD. Blocos são desenhos criados pelo usuário, que ficam na memória do programa e podem ser inseridos a qualquer momento no arquivo, sem a necessidade de redesenhá-los. Desse modo, o usuário pode criar uma biblioteca de símbolos de hidráulica e elétrica, peças mecânicas, mobiliários, etc., que serão desenhados apenas uma vez e acessados todas as vezes que precisar.

Make Block
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O comando Make Block possibilita a criação de um símbolo que só poderá ser acessado dentro do arquivo em que foi criado.  Primeiramente deve ser feito normalmente o desenho dos objetos que se quer transformar em bloco. Depois se utiliza este comando para criar o bloco. Onde Encontrar: Menu Draw ( Block.
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Block Name – define o nome como será conhecido o bloco. Deve conter até 31 caracteres.

Base Point – permite darmos o ponto de inserção do bloco através das coordenadas ou de um ponto na tela (Select Point). O ponto de inserção é o ponto de referência cuja localização será pedida ao entrarmos com a figura em um arquivo.

Select Objects – Permite a seleção dos objetos que farão parte daquele bloco.

List Block Names – mostra a lista de todos os blocos existentes no desenho.

Retain Objects – quando esta opção está ligada, as entidades selecionadas para criação do bloco permanecerão na tela, como entidades individuais, após a utilização do comando. Caso esteja desligada, as entidades escolhidas serão apagadas, após a utilização do comando.

Wblock

Permite criar blocos que podem ser acessados em todos os arquivos. Na verdade, cria-se um novo arquivo .DWG com o nome dado.

Onde Encontrar: Digite Wblock.

Para transformar um Block em Wblock:

1.  No quadro de diálogo, defina o nome e o diretório do Wblock.

2.  Na tela, digite o nome do bloco a ser transformado em Wblock.

Para criar um WBLOCK:

1.  No quadro de diálogo, defina o nome e o diretório do Wblock.

2.  Ao invés de digitar o nome, tecle ENTER.

3.  Defina o ponto de inserção do WBLOCK.

4.  Selecione os objetos que farão parte do WBLOCK.

Dica: Dessa forma, todos os arquivos .DWG são WBLOCKs, podendo o usuário inserir um arquivo qualquer em outro. O ponto de inserção, nesse caso, é o 0,0. Caso se queira modificar este ponto de inserção, utilize o comando Draw ( Block ( Base.

Insert Block
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Este é o comando utilizado para inserir blocos no seu desenho, tanto os criados pelo comando MAKE BLOCK quanto pelo comando WBLOCK. Onde Encontrar: Menu Insert.

Block - Abre o quadro onde estão listados todos os blocos do desenho. Para selecionar um, basta clicar no nome.

File - Abre o quadro de arquivos, escolhendo-se normalmente, como se fôssemos abrir um arquivo.

Options - Permite definirmos o ponto de inserção (coordenadas), o fator de escala e o ângulo de rotação do bloco a ser a inserido. Se ligarmos a opção Specify Parameters on Screen, daremos todas essas opções na tela de trabalho.

Explode - permite que um bloco seja inserido não como uma só entidade, mas como as entidades individuais que os compõe.

Com o Specify Parameters on Screen ligado:

1.  Com um clique (coordenadas, mouse ou ferramentas) especifique o ponto onde ficará o ponto de inserção (ponto de referência dado quando da criação do bloco).

2.  Determine o fator de escala no eixo X. A resposta ENTER aceita o valor default 1 (o bloco fica do tamanho que foi criado).

3.  Determine o fator de escala no eixo Y. A resposta ENTER aceita o default Y scale = X scale.

4.  Determine o ângulo de rotação do bloco, digitando, ou clicando na tela.

Dica: Quando o bloco é inserido no desenho, ele é uma entidade só. Para transformá-lo nas entidades individuais que o compõe utilize o comando EXPLODE.

· Minsert (Múltiplas inserções)

O comando Minsert permite inserir o mesmo bloco mais do que uma vez com um padrão retangular (Array do bloco). A seqüência do comando, depois das perguntas de ponto de inserção , escala e angulo de rotação, é:

Number of rows (--) <1>: (número de linhas) (enter)

Number of columns(|||) <1>: (numero de colunas) (enter)

Unit cell or distance rows <1>: (distância entre os blocos em linha) (enter)

Distance between columns (|||) <1>: (distância entre os blocos em coluna) (enter)

Obs.: Uma vez o bloco inserido, não existe modo de alterar o número de linhas e colunas criadas.

· Rename (Renomear)

Este comando permite dar um outro nome ao objeto associado a entidade de desenho.

Menu pull-down Format => Rename

ou

Command: Rename (enter)

Block/ Dimsion styles/ LAyers/ Linetypes/Text styles/ UCSs/ Viewports/ View: (escolher opção e os itens da opção))

Old name: (nome antigo) 
Rename to: (novo nome) (ok)

· Xref (Referência externa)

Imagine que seu projeto é necessário para que outros profissionais possam desenvolver o seu trabalho e não podem esperar que você termine para trabalharem sobre ele. O comando Xref pode resolver este problema. Isto é, se cada um dos profissionais inserir no seu desenho, como Xref, o seu projeto, este vai refletir as últimas alterações realizadas por você. 

Os Xrefs (referências externas) são entidades semelhantes aos blocos, mas, ao contrario destes, os Xrefs salva suas informações no desenho origem e não no desenho corrente, por isso, não sobrecarregam tanto a memória. Também, permite uma atualização constante a medida que você for atualizando o seu projeto.

Command: Xref (enter)

ou

Menu pull-down Insert => External Reference…

· 1º Clique em Attach para inserir ao desenho corrente um arquivo DWG.

· 2º Duplo clique no desenho pretendido.

· 3º Insertion point: (dar o ponto de inserção por coordenadas ou usando o mouse) (enter)
· 4º X scale factor <1>/ Corner/ xyz: (dar o fator de escala para cada eixo) (enter)
· 5º Y scale factor (default=X): (enter)
· 6º Rotation angle <0>: (dar o ângulo de rotação) (enter)
Opções deste comando:

Attach: insere no desenho corrente um arquivo .DWG.

Bind: transforma os Xrefs em blocos, que passam a pertencer permanentemente ao seu desenho.

Detach: remove Xrefs do seu desenho corrente.

Reload: atualiza os Xrefs inseridos ao desenho corrente, de forma a refletirem alterações dos seus desenhos .DWG associados.

22. Comandos de Dimensionamento 

Conceitos Básicos:

Dimension Line (linha de dimensão) - É a linha entre as duas linhas de chamada, onde está escrito o texto da cota.

Extension Line (linha de extensão) - É a linha de chamada da cota, que vai da entidade até a linha de dimensão.

Dimension Text (texto de dimensão) - É o texto da cota.

[image: image25.png]



DIMENSIONAMENTO LINEAR

Onde Encontrar: Menu Dimension.

Linear

[image: image26.png]


Dimensiona pela variação horizontal ou vertical entre os dois pontos dados, projetados sobre o eixo x ou y, respectivamente, dependendo da localização da linha de dimensão.

1.  Especifique o ponto de onde partirá a primeira linha de chamada (Extension Line), ou tecle ENTER para selecionar o objeto a ser cotado.

2.  Especifique o ponto da segunda linha de chamada.

3.  Especifique o local da linha de dimensão ou escolha uma das opções descritas abaixo. Dependendo do ponto, esta cota será horizontal ou vertical. A posição da cota é mostrada na tela, on-line.
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         Dimensionamento Horizontal


Dimensionamento Vertical

Atenção: Caso o espaço a ser cotado seja menor que o texto da cota, este vai para o lado de fora. No quadro de Dimension Style pode-se especificar que o texto esteja sempre dentro.
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Aligned

Cota alinhando a linha de dimensão com os dois pontos dados.

1.  Especifique o ponto de onde partirá a primeira linha de chamada (Extention Line), ou tecle ENTER para selecionar o objeto a ser cotado.

2.  Especifique o ponto da segunda linha de chamada.

3.  Especifique o local da linha de dimensão ou escolha uma das opções abaixo:
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Dimensionamento Alinhado
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Baseline
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Esta opção cota utilizando um ponto base que é o primeiro ponto da cota inicial (dada por dimensionamento linear ou alined), sendo que as outras cotas são feitas com distâncias em relação a este ponto.

1.  Dê uma primeira cota por dimensionamento linear ou aligned que será usada como base para as próximas.

2.  Entre no comando Baseline e especifique o segundo ponto da cota ou tecle ENTER ou S (Select) para escolher qual cota será tida como base. Para desfazer a última cota feita nesta sessão, utilize a opção Undo.
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Continue
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Este modo permite cotar várias vezes numa mesma linha, sendo que o primeiro ponto da próxima cota é sempre o último da cota anterior.

1.  Dê uma primeira cota por dimensionamento linear ou aligned que servirá de base para as outras.

2.  Especifique o segundo ponto da cota ou tecle ENTER ou S (Select) para escolher qual cota será tida como base para continuação. Para desfazer a última cota feita nesta sessão, utilize a opção Undo.




Atenção: Se o texto da cota anterior estiver do lado de fora, a próxima cota do Continue não será colocado no mesmo alinhamento. 

DIMENSIONAMENTO CIRCULAR

Radius

[image: image30.png]


Cota raios e círculos e arcos.

1.  Selecione o círculo ou arco.

2.  Defina o local do texto da cota ou escolha uma das opções abaixo:
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Diameter
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Cota diâmetros de círculos e arcos.

1. Selecione o círculo ou arco.

2. Defina o local do texto da cota ou escolha uma das opções abaixo:
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DIMENSIONAMENTO ANGULAR

Angular
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Cota ângulos entre duas entidades que se encontram em um vértice, ângulo de varredura de um arco ou ângulo de um trecho de um círculo (determinando-se dois pontos do círculo).

1.  Selecione o primeiro objeto.

2.  Selecione o segundo objeto.

3.  Determine a posição da linha de dimensão ou escolha uma das opções abaixo:
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UTILITÁRIOS DE DIMENSIONAMENTO

Center
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Marca o centro de um círculo ou arco.

Leader
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É utilizado para adicionar notas escritas sobre determinado objeto. Estas observações são feitas com a utilização de uma linha com uma seta na extremidade que liga o objeto ao texto ou a um bloco. Utiliza o comando MTEXT.

1. Especifique o ponto de onde partirá a seta.

2. Dê o segundo ponto da linha.

3. Dê um terceiro ponto, se necessário, tecle ENTER para começar a escrever ou escolha uma das opções abaixo:
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DIMENSION STYLE (Estilo de Dimensionamento)
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Este comando permite configurar a aparência de uma cota, permitindo criar vários estilos de dimensionamento para um mesmo desenho.

Onde Encontrar: Menu Dimension.
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As opções do quadro de diálogo são:

Dimension Style – Esta seção gerencia os nomes do estilos.

· Set Current – Mostra o estilo em vigência. Clicando-se na seta da direita, serão mostrados os nomes de todos os estilos de dimensionamento presentes no desenho, permitindo a mudança de estilo corrente.

· New – Este campo serve criar novos estilos 

· Modify - Esta seção define qual tipo de texto, setas, etc, que serão usados no estilo criado ou modifica o estilo em uso, permitindo que se façam mudanças, por exemplo, apenas nas cotas do tipo Radius, sem alterar os outros tipos de cota do mesmo estilo. A ação de mudar apenas a configuração de um tipo de cota se dá o nome de Override. 

· Compare – Esta opção permite que sejam comparados dois estilos  de dimensionamento.
MODIFY DIMENSION STYLE – LINES AND ARROWS
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Dimension Line – Esta seção ajusta a aparência da linha de dimensão:

· Color – Altera as cores da linhas de cotas (BY LAYER é a melhor opção)

· Lineweight – Espessura (pena) das linhas de dimensão (BY LAYER)

· Extend Beyond Ticks – Ajusta o quanto a linha de dimensionamento passa do tick (ao lado)

· Baseline Spacing – Define o espaçamento entre as linhas de cotas de um dimensionamento contínuo.

· Supress – Permite suprimir uma das duas partes da linha de dimensão, ou ambas, quando o texto está centrado em relação a mesma. Para que a primeira parte da linha de dimensão não seja desenhada ative 1st (dimsd1), para a segunda ative 2nd (dimsd2).

· Extension (dimdle) – Esta opção pode ser usada quando estão sendo utilizadas as setas Oblique, Architectural, Tick e Integral ou não estão sendo usadas setas para marcar a cota. Ela define a distância a qual a linha de dimensão ultrapassará as linhas de chamada.

· Spacing (dimdli) – Determina a distância entre as linhas de dimensão das cotas nas opções Baseline e Continue.

Extension Lines – Esta seção define a aparência das linhas de chamada:

· Color – Altera as cores da linhas de extensão para as cotass (BY LAYER é a melhor opção)

· Lineweight – Espessura (pena) das linhas de extensão  (BY LAYER)

· Extend Beyond Ticks – Ajusta o quanto a linha de extensão passa do tick (p/ cima)

· Origin Offset (dimexo) – Controla a distância entre o ponto de referência dado para desenhar a cota (Node) até o início da linha de chamada

· Supress – Permite que sejam suprimidas a primeira, a segunda ou ambas linhas de chamada. Para suprimir a primeira linha de chamada ative 1st (dimse1), para a segunda ative 2nd (dimse2).

Arrowheads – Nesta seção será definida que figura será inserida em cada uma das extremidades da cota:

· 1st (dimblk1) – Define a figura (ponta de seta) que será colocada na primeira extremidade da cota. A figura é mostrada no quadro acima da seção.

· 2nd (dimblk2) – Define a figura (ponta de seta) que será colocada na segunda extremidade da cota. A figura é mostrada no quadro acima da seção.

· Size (dimasz) – Define o tamanho das pontas de seta, em unidades.

Center Marks for Circles – Esta seção definirá como se apresentará o centro de círculos e arcos desenhados pelo dimensionamentos Radius, Diameter e Center.

· Mark (dimcen) – Quando está marcada, esta opção desenha duas linhas perpendiculares que marcam o centro do círculo ou arco.

· Line (dimcen) – Esta opção desenha, além das duas linhas perpendiculares, linhas complementares passando pelos quadrantes.

· None (dimcen) – Esta opção desabilita a marca de centro.

· Size – Define o tamanho da marca de centro.

 MODIFY DIMENSION STYLE – LINES AND ARROWS

[image: image38.png]Layoutname. Foge setup name
Model 7 Saye changes to ayout Select page selup o applp> ¥] _ Add

Plot Device PlotSettings |

Paper size and paper units
Flot device: & None

Foper size

Pritable area: 28200117000 7m

Plot area

€ Linits
-
 Display

ol =
!

o) Windaw <

150 A4 (257.00 % 210.00 Wb -

Diawing orertation
€ Portat

 Landscape

Clnches € mm I~ Plot upsice-down

Plot scale

Soale Custom <
- draing urits

Custom: [0 o

o

Plotofset Flot options
7 Certer the plot I

% Plotwithplot syl
o
W Hidk sbigcis

X [281676 |

¥: [140000 o

[ Cancel Help





TEXT APPEARENCE - Determina a formatação do texto de cotas.

· Text Style – Seleciona  um estilo de texto criado (DIMTXTSTY)  na tela aparece o estilo corrente.

· Text Color- Troca as cores utilizadas nos textos das cotas.

· Text Height – Determina a altura do texto.

· Fraction Height Scale - Ajusta a escala do texto relative.to da dimensão das fraçõesDraw Frame Around Text – Cria uma moldura em torno do texto da cota

TEXT PLACEMENT - Controla a localização do texto de dimensão.

· Vertical Position - Controla a justificação vertical do texto da dimensão ao longo da linha da dimensão.O AutoCAD armazena o valor das opções verticais da justificação na variável do sistema de DIMTAD. As opções verticais da posição incluem o seguinte: 

· Centered: Centra o texto da dimensão entre as duas partes da linha da dimensão.

· Above: Coloca o texto da dimensão acima da linha da dimensão. A distância da linha da dimensão à linha de base da linha a mais baixa do texto é a atual do texto.

· Outside: Coloca o texto da dimensão ao lado da linha de dimensão. O afastamento é definido por um ponto. 

· JIS: Coloca o texto da dimensão para conformar-se a uma respresentação japonesa dos padrões industriais (JIS).

MODIFY DIMENSION STYLE – FIT
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Determina a localização da dimensão do texto, pontas de setas linhas guias e linhas de cota. 
FIT OPTIONS - Controla a colocação do texto e das setas internas ou das linhas de extensão exteriores baseadas no espaço disponível entre as linhas de extensão. Quando o espaço está disponível, AutoCAD coloca sempre o texto e os arrowheads entre as linhas de extensão. Se não, o texto e os arrowheads são colocados de acordo com as opções ajustadas. O AutoCAD armazena este valor variáveis no sistema de DIMATFIT, de DIMTIX, e de DIMSOXD.

· Either the Text or the Arrows, Whichever Fits Best - Quando há espaço disponível para o texto e setas, coloca ambos entre as linhas de extensão. Se não, O AutoCAD move o texto ou as setas baseado no melhor ajuste. 

· Arrows - Quando não há bastante espaço o texto e setas o texto fora das linhas de extensão. 

· Text – Quando não há bastante espaço o texto e setas, as setas ficam fora das linhas de extensão.
· Both Text and Arrows - Quando não bastante espaço está disponível para o texto e os arrowheads, coloca ambo a parte externa as linhas de extensão.

· Always Keep Text Between Ext Lines - Coloca sempre o texto entre linhas de extensão. AutoCAD armazena este valor na variável do sistema de DIMTIX.

· Suppress Arrows If They Don't Fit Inside Extension Lines - Suprime setas(ou qualquer final de linha escolhido) se não houver bastante espaço dentro das linhas de extensão. OAutoCAD armazena este valor na variável do sistema de DIMSOXD.

TEXT PLACEMENT - Ajusta a colocação do texto da dimensão quando é movida da posição da opção, isto  é, a posição definida pelo estilo da dimensão. As opções do movimento do texto são armazenadas na variável do sistema de DIMTMOVE

· Beside the Dimension Line - Texto da dimensão dos lugares ao lado da linha da dimensão.

· Over the Dimension Line, with a Leader - Se o texto for movido afastado da linha da dimensão, cria um líder que conecta o texto à linha da dimensão. O AutoCAD omite o líder quando o texto é demasiado perto da linha da dimensão.

· Over the Dimension Line, Without a Leader - Mantem a linha da dimensão no mesmo lugar quando o texto é movido. O texto que é movido afastado da linha da dimensão não é conectado à linha da dimensão.

· SCALE FOR DIMENSION FEATURES - Ajusta o valor de escala da dimensão total ou o scaling de papel do espaço.

· Use Overall Scale Of - Ajusta uma escala para todos os ajustes do estilo da dimensão que especificam o tamanho, a distância, ou o afastamento incluindo tamanhos do texto e das setas Esta escala não muda valores da medida da dimensão. AutoCAD armazena este valor na variável do sistema de DIMSCALE.

· Scale Dimension to Layout (Paper Space)- Determina um fator de escala baseado na escala entre o viewport modelo atual do espaço e o espaço de papel.

· Fine Tuning Option - Ajusta opções adicionais.

· Place Text Manually When Dimensioning -Ignora quaisquer ajustes horizontais da justificação e coloca o texto na posição que você especifica no alerta da posição da linha da dimensão. AutoCAD armazena este valor na variável do sistema de DIMUPT

· Always Draw Dim Line Between Ext Lines - Desenha linhas da dimensão entre os pontos medidos mesmo quando O AutoCAD coloca a parte externa dos arrowheads os pontos medidos. AutoCAD armazena este valor na variável do sistema de DIMTOFL.

MODIFY DIMENSION STYLE – PRIMARY UNITS
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LINEAR DIMENSIONS - Ajusta o formato e a precisão para dimensões lineares

Unit Format - Ajusta as unidades atuais formatadas para todos os tipos da dimensão a não ser que angular. As opções que podem ser selecionadas incluem científico, decimal, projetar, architectural, fracionário, e os Windows desktop. AutoCAD armazena este valor na variável do sistema de DIMLUNIT

Precision – deteremina a quantidade de decimais no texto da dimensão. O AutoCAD armazena este valor na variável do sistema de DIMDEC.

Fraction Format - Ajusta o formato para frações. As opções a selecionar de incluem diagonal, horizontal, não empilhado. O AutoCAD armazena este valor na variável do sistema de DIMFRAC.

Decimal Separator - Ajusta o separador para formatos decimais. As opções a selecionar de incluem o período (.), vírgula (), ou o espaço (). AutoCAD armazena este valor na variável do sistema de DIMDSEP
Round Off - arredondam os valores das medidas da dimensão para toda a dimensão digitadas a não ser que angulares. Incorpore um valor à caixa de texto.
Prefix e Suffix - pode incorporar ao símbolos especiais Por  exemplo, dar entrada ao código %%c docontrole indica o símbolo de diâmetro. Quando você incorpora um prefixo, cancela todos os prefixos da opção tais como aquelas usadas no cálculo de dimensões do diâmetro (Ø) e do raio (r). AutoCAD armazena o prefixo na variável do sistema de DIMPOST.

MEASUREMENT SCALE - Define opções da escala de medidas

· Scale Factor - Ajusta um fator de escala para medidas lineares para todos os tipos da dimensão a não ser que angular.O AutoCAD multiplica a medida da dimensão pelo valor incorporado aqui. Por exemplo, se você incorporar 2, O AutoCAD indica uma dimensão one-inch como duas polegadas. O AutoCAD armazena o valor de scaling do comprimento na variável do sistema de DIMLFAC.

· Apply to Layout Dimensions Only: - Aplica o valor de escala linear somente as dimensões criadas nas disposições. Isto é, ajusta o fator de escala do comprimento para refletir o fator de escala do zoom para objetos em um viewport modelo do espaço. Quando você seleciona esta opção, O AutoCAD armazena o valor de scaling do comprimento como um valor negativo na variável do sistema de DIMLFAC..

ZERO SUPPRESSION - Controla a supressão dos zero

· Leading: Suprime zero principais em todas as dimensões decimais. Por exemplo,0,5000 transformam-se 5000.

· Trailing - Suprime zero arrastando em todas as dimensões decimais. Para o exemplo, 12,5000 transformam-se 12,5, e 30,0000 transformam-se 30.

· Usando os GRIPS para alterar as cotas

As cotas no AutoCAD estão ligadas a determinados pontos (definition points) através dos quais podemos editar as cotas. Para fazer alterações nas cotas podemos usar os grips.

Para alterar a localização da cota usando grips:

1º selecione a cota que pretende editar;

2º clique no grip a partir do qual pretende modificar a cota;

3º mova o cursor.

· Modificando cotas individuais

1º clique em Properties na Object Properties Toolbar;

2º Select objects: (selecione a cota que pretende editar) (enter);

3º faca as modificações na caixa de dialogo Modify Dimension;

4º clique ok.

23. Impressão/Plotagem

PRINT / PLOT

Este comando permite a impressão de um desenho através de uma impressora ou plotter.

PLOT DEVICE - Especifica o plotter, a mesa digitalizadora (se for o caso) estilos de plotagem, e plotagem para arquivos (arquivos plt) 
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Save Changes to Layout – Salva suas alterações nesta caixa de diálogos.

Page Setup Name - Mostra uma lista de instalações já nomeadas e conservadas da página.Você pode escolher e basear a instalação da página atual em uma página nomeada para setup, ou você pode adicionar uma página nomeada nova para setup escolhendo adicionando -a

Plotter Configuration –  Mostar um lista de plotters ou impressoras que pode se utilizadas, se a sua impressora não estiver nesta lista é porque vc precisa instalar. 

· Properties - Configurações do Plotter (impressora) escolhido.

· Hints – Informações específicas sobre o plotter escolhido

Plot Style Table (Pen Assignments) - Informação sobre o modo de impressão (colorido, monocromático, escalas de cinzas...) 

· Edit – Permite alterar as configurações atuais

· New – permite criar uma nova configuração

What to Plot – Define como e o que você quer plotar

· Current Tab Plota o modelo (prancha) corrente

· Selected Tabs – Partes da prancha selecionada.

· All Layout Tabs – Tudo que estiver desenhado na Prancha

· Number of Copies – Define quantas cópias você quer tirar.
Plot to File – Transforma seu arquiv dwg em um arquivo plt

File Name - Nome do arquivo para ser transformado em plt

Location -  Mostra onde ficará guardado o arquivo.

PLOT SETTINGS - Especifica o tamanho do papel, a orientação, a área e a escala do arquivo, o offset, e as outras opções.
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Plot Device – Mostra o plotter escolhido

Paper Size – Determina o tamanho do papel

Printable Area – Mostra a área que será usada para impressão baseado no tamanho real do papel

· Inches – Polegadas como unidade de plotagem

· MM – Milimétros como unidades de plotagem.

Drawing Orientation - Especifica a orientação do desenho no papel para os plotadores que suportam a orientação da paisagem ou do retrato. Você pode mudar a orientação desenhando para conseguir um  giro de 0 -, 90 -, 180 -, 270-graus de rotação.

· Portrait – a orientação do papel é vertical

· Landscape – Orientação horizontal

· Plot Upside-Down – Desenha o arquivo de cabeção para baixo

Plot Area – Especifica a parte do desenho a ser impressa

· Layout – As partes do arquivo dentro das margens e do tamanho do papel especificado, com a origem calculada de 0.0 na disposição. Disponível somente quando uma disposição for selecionada. Se você escolher desligar os limites se transfomarão em uma área delimitada pela forma window ou pelos objetos selecionados.

· Limits – plotam a área definida pelos limites do desenho.

· Extents - Traça a parcela do espaço atual do desenho que contem objetos. Display – Traça o que é visto na janela selecionada

· View –Desenha uma vista salva previamente com o comando da View Você pode selecionar uma vista da lista fornecida. Se não houver nenhuma vista

· salva no desenho, esta opção não será habilitada.

· Window – Desenha uma parte do desenho selecionada por uma janela
Plot Scale - Controla a escala do desenho. O Padrão é 1:1 

Scale Especifica a escala exata que você quer imprimir do seu desenho

Custom -  Você pode criar uma escala específica de plotagem

Scale Lineweights –Escala da espessura das linhas

Plot Offset – Determina a área de impressão pelas coordenadas

· Center the Plot – Centraliza automaticamente a área a ser impressa 

· X- Determina a origem da plotagem no eixo dos X

· Y - Determina a origem da plotagem no eixo dos X

Plot Options - Especifica opções para espessura das linhas, estilos do plotagem ou o atual. 
· Plot with Lineweights - 
· Plots lineweights. Ajuste de penas

· Plot with Plot Styles – Utiliza um estilo de plotagem escolhido

· Plot Paperspace Last – Utiliza o Paper Space

· Hide Objects – Esconde a forma wireframe

24. Configurando o Ambiente de Trabalho

· Preferences (Preferências) 

Permite várias opções de configuração da interface do AutoCAD com o usuário.

Command: Preferences (enter)

Ou

Menu pull-down Tools => Preferences

Opções da caixa de diálogo:

· Files: especifica as localizações onde o AutoCAD irá procurar por default os arquivos.

· Performance: configura a precisão e aspectos dos objetos e superfícies, bem como a quantidade de viewports e outros parâmetros.

· Display: permite controlar aspectos da visualização da tela, como por exemplo muda as cores e fontes da tela e ativa e desativa o screen menu. 

· General: ativa a gravação automática.

· Screen Menu (Menu de Tela)

Este menu aparece do lado direito da tela e é constituído por itens de submenu e itens de comando que o usuário pode selecionar através do indicador do mouse.

· Criar e Modificar Novas Toolbars 
Para criar uma nova Toolbar (barra de ferramentas):

View=> Toolbars =>New=> digite um nome => OK=> Customize=> clique no ícone de comando que pretende copiar e arraste-o para dentro do novo Toolbar.
Obs. 1: para apagar um ícone de comando, arraste-o para fora da Toolbar. 
Obs. 2: para editar diretamente os ícones das várias Toolbars da tela do AutoCAD pressione a tecla Ctrl e arraste o ícone para a nova Toolbar.
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